
 

FISCAL YEAR 2017–18 

PRINCIPAL APPORTIONMENT 
TAX SOFTWARE 
VERSION 17.00 

DATA REPORTING INSTRUCTION MANUAL 
(Tax Software Supplement) 

 

October 2017 

California Department of Education 
School Fiscal Services Division 

1430 N Street 

Sacramento, CA 95814



 

 
 

Table of Contents 
Introduction ................................................................................................................ 1 
Printing Reports and Certifications ......................................................................... 2 

Printing from the Main Menu .................................................................................... 2 
Printing Blank Reports ............................................................................................. 3 
Printing Certifications ............................................................................................... 3 
Selecting LEAs and Programs for Printing ............................................................... 3 

Changing Periods ...................................................................................................... 4 
Changing Reporting Periods .................................................................................... 4 
Saving Data in P-2 and Annual Reporting Periods................................................... 4 

Taxes .......................................................................................................................... 5 
Data Entry Instructions ............................................................................................. 5 
General Instructions ................................................................................................. 6 
Cross-County Taxes ................................................................................................ 8 
Prior Year Tax Adjustments ..................................................................................... 9 
Copying Tax Data from One Period to Another ........................................................ 9 

 



 

 

Introduction 
 
This Data Reporting Instruction Manual (Tax Software Supplement) is intended to help users complete 
the data entry screens in the Principal Apportionment Tax Software, which is released prior to the full 
Principal Apportionment Data Collection (PADC) Software. The data entry screens for reporting taxes 
and information contained in this supplement will also be included in the Data Reporting Instructional 
Manual that will be released with the PADC Software. 
 
For additional information on how to navigate the Tax Software, please refer to the Principal 
Apportionment Tax Software User Guide at 
http://www.cde.ca.gov/fg/sf/tc/documents/taxuserguide1718.pdf. 
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Printing Reports and Certifications 
 
Print a report from an open entry screen by clicking File, and then clicking Print. The Print Preview 
window displays the printed report. 
 
NOTE: If you print a report from an entry screen, you must save that data before you can print. Saving 
the data also ensures that the most current data (instead of the previously saved data) displays in your 
report. 
 
You may be able to resize the window so you can view more of the report. You can also use the scroll 
bars at the right and bottom of the window to scroll vertically and horizontally to view more of the report. 
The report page number displays in the lower left hand corner of the window, and if there are multiple 
pages, use the arrow buttons to scroll through the pages. 
 
The Print Preview screen contains the following functions: 

Button/Function Description 

 Printer button 
Sends the report to the printer. 

 Export to HTML or text button 
Exports the report into an HTML or text file. Do not use this 
button for exporting the data that is sent to the California 
Department of Education. 

  
Zoom drop-down list 

Sets the magnification level from the drop-down list. 

 Navigate to the first page button Moves to the first page in the report. 

 Navigate to the previous page button Moves to the previous page in the report. 

 Navigate to the next page button Moves to the next page in the report. 

 Navigate to the last page button Moves to the last page in the report. 

 
You can close the window without printing or exporting the report by clicking on the Close (X) button at 
the top right corner of the Print Preview window title bar. 
 
Printing from the Main Menu 
 
Before you print from the Main Menu, you must select the local education agency (LEA) and the entry 
screen(s) to be printed. The following types of reports can be printed: Entry Screen Reports, 
Certification Reports, and Summary Reports. 
 
After you print the reports the Status window displays the results from printing the report. 
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The Status window displays the success or failure of the printing process. You can save the status 
report by clicking the Save button, or print the status report by clicking the Print button. Close the Status 
screen without printing or saving by clicking the Close button. 
 
Printing Blank Reports 
 
Due to changes to the software, this feature is not available for the 2017–18 Fiscal Year. 
 
Printing Certifications 
 
You must export your data to a certified data file before you can print certifications.  
 
Print the certification(s) for your selected LEA or Entry Screen from the File menu by clicking Print, and 
then clicking Certification. The certification(s) are sent to your printer immediately. You cannot preview 
the certification(s) before you print them. 
 
NOTE: After you export your file, you must print your certification and get the proper signatures. Keep 
the original signed certification on file at the county office of education (COE). 
 
The Status window displays the success or failure of the printing process. You can save the status 
report by clicking the Save button, or print the status report by clicking the Print button. Close the Status 
screen without printing or saving by clicking the Close button. 
 
Selecting LEAs and Programs for Printing 
 
To print the Reports and Certifications from the Main Menu: 
 

1. Click the far left column of any LEA to activate the Entry Screens grid. 
 
2. Click the Selected column cell of the LEA in the Entry Screens grid to change the cell to "Yes". 
 
3. Click the Selected column cell of the program in the Entry Screens grid to change the cell to 

“Yes”. 
 

4. Select Print from the File menu and then select the desired Report or Certification.  
 
5. The report is sent directly to the printer and the Status window displays. 
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Changing Periods 
 
The Period menu allows you to switch between different reporting periods for the current fiscal year and 
for corrections.  
 
There are three tax reporting periods for each fiscal year in the software, the P-1, P-2, and one reporting 
period for corrections, Annual. The default reporting period is P-1 when you logon to the software for the 
first time. After the first time you logon, each time you re-open the program, it will open to the last 
reporting period used. 
 
Changing Reporting Periods 
 
When reporting data for the current fiscal year, select a period by selecting P-1, P-2, or Annual from the 
Period menu. When correcting data for a prior period, select Corrected from the Period menu, then 
select Annual from the sub-menu. A checkmark displays next to the selected period in the Period menu 
or Corrected sub-menu.  
 
NOTE: You must use the software from the appropriate fiscal year to make any prior year corrections. 
For example, to make corrections to 2016–17 data, you would use the 2016–17 software even after the 
2016–17 fiscal year. 
 
Saving Data in P-2 and Annual Reporting Periods 
 
Any data that is changed and saved replaces previously saved data for that period. If you change and 
save Annual corrected period data, the data changes OVERWRITE the previously saved Annual period 
data. Conversely, if you change and save Annual data in the “standard” reporting period (meaning from 
the Period menu, not from the Period menu’s Corrected sub-menu), the saved changes will 
OVERWRITE any existing Annual corrected period data. 
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Taxes 
Data Entry Instructions 
 
The Taxes entry screen is only available to users from the County Office and County Auditor user 
groups. To access the Taxes entry screen, select County Auditor from the LEA menu. Open the entry 
screen from the Entry Screens grid. 
 
Key Tax Filing Dates, EC Section 41760.2 
 

Period to Report 2017–18 Reporting Deadlines 
First Period Taxes Report Send to CDE no later than November 15 

Second Period Taxes Report Send to CDE no later than April 16 

Annual Taxes Report Send to CDE no later than August 15 
 
You must add a new record or select an existing record before you can enter data into the Taxes 
screen. 
 
When you open the Taxes screen, you must first select County or District from the Select TAX Type 
drop-down list.  
 
If no records exist for the tax type selected, a message box reminds you to click the Add New button to 
add a new record. You may need to add more than one record if you report taxes for more than one 
county or district. The message box only displays if no records exist. Close the message box by clicking 
OK. 
 
After you add a new record you can enter County Auditor tax data for that record. 
 
To add a new record: 
 

1. Click Add New. The Add New Record dialog box displays. 
 

2. Add new record information in the Add New Record dialog box by selecting from both of the 
following two drop-down lists described below. 
 

Drop-down List Description 

County of Residence Select the county of residence for which the tax is being 
reported. 

District of Residence Select the school district of residence for which the tax is being 
reported. 

 
3. Click Add Record. 

 
After you enter data into the screen, you can click Save, Cancel, or Close the record. You can add 
another record by clicking Add New or delete a saved record by clicking Delete. You can scroll through 
the records by using the scroll buttons. 
 
You can print reports that display county and school district taxes from this entry screen. 
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General Instructions 
 
Taxes are reported pursuant to Part 0.5, Chapter 3.5, Article 7, Section 75.70, et seq., and Chapter 6, 
Articles 1–6, Section 95, et seq., of the Revenue and Taxation Code (RTC), and Part 24, Chapter 7, 
Article 2, sections 2575(c) and 42238.03(c) of the Education Code (EC). Taxes are reported on a cash 
rather than accrual basis. Please report whole dollars only. 
 
County taxes allocated for purposes of the Child Development Fund must be included in Lines A-1,  
A-2, and A-4. 
 
The following table describes the fields displayed in this screen and instructions on the data to be 
reported for each tax category. Additionally, where applicable, the standardized account code structure 
(SACS) Resource and revenue Object codes have been provided to assist users with reporting tax data. 
LEAs use SACS codes to record and report revenue and expenditure data. More information regarding 
SACS is available on the CDE Web page at http://www.cde.ca.gov/fg/ac/ac. 
 

Line 
Number 

Field 
Description Instructions 

SACS 
Resource 

and 
Revenue 
Object 
Codes 

A-1 Secured Amount of secured taxes (including old area wide 
taxes to school districts). 

0000 - 8041 

A-2 Unsecured Amount of unsecured taxes (including old area 
wide taxes to school districts). 

0000 - 8042 

A-3 HOX 
Subventions 

Amount of the state subventions to be received for 
purposes of homeowner’s exemptions. 

0000 - 8021 

A-4 Misc. 
Taxes/Other 
Appropriate 
Local Revenues 
or Subventions 

Amount of Miscellaneous Taxes/Other Appropriate 
Revenues or Local Revenues Subventions. 
A partial list of Miscellaneous Taxes and 
Subventions to be reported in A-4 is as follows: 

 Business or Professional Records 
Assessed Valuation Reduction 

 Church Parking Lot Exemption 

 Veteran’s Property Tax Exemption 

 Tax Deeded Land for Highway Rental 

 Housing Authority 

0000 - 8029 

A-5 Distribution of 
Timber Yield 
Taxes 

Amount of Timber Yield Tax. 0000 - 8022 

A-6 Distribution of 
Prior Year Taxes 

Amount of prior fiscal year penalties, interest, 
delinquent property taxes, and property tax 
redemption monies collected and disbursed in the 
current year.  

0000 - 8043 

http://www.cde.ca.gov/fg/ac/ac
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Line 
Number 

Field 
Description Instructions 

SACS 
Resource 

and 
Revenue 
Object 
Codes 

A-7 Release of Prior 
Year Tax 
Impounds [EC 
14240] 

Amount of prior fiscal year tax impounds released 
and disbursed in the current year as pursuant to 
EC Section 14240. 

0000 - 8043 

A-8 Supplemental 
Taxes from 
Increased 
Assessment 
[RTC sections 
75.70-75.72] 

Amount of supplemental taxes generated by 
increased assessments per RTC sections 75.70-
75.72. Current and prior year Supplemental Taxes 
are reported in the fiscal year these taxes are 
collected. Supplemental taxes cannot be 
distributed to basic aid school districts [RTC 
Section 75.70(2)]. Per RTC Section 75.70(e), the 
State Superintendent of Public Instruction (SSPI) 
annually notifies county auditors of the Advance 
Apportionment ADA used to allocate supplemental 
taxes, and as required, the ADA for excess tax 
districts is set to zero. This field will be blocked for 
these school districts. The Advance Apportionment 
ADA list is available by accessing the Principal 
Apportionment page on the CDE Web page at 
http://www.cde.ca.gov/fg/aa/pa, selecting the 
appropriate fiscal year, and is located below the 
section labeled “Other Fiscal Information”. Also, 
supplemental taxes cannot be allocated to school 
districts that are not members of the county’s 
public school system [RTC Section 75.70(d)(1)]. 

0000 - 8044 

A-9 Educational 
Revenue 
Augmentation 
Fund 

Based on the information provided by the county 
superintendent of schools and school districts, 
enter the amount of the Educational Revenue 
Augmentation Fund (ERAF) disbursed to the 
county’s school districts and county office of 
education. 

0000 - 8045 

A-10 Prior Year 
Restricted 
Monies [EC 
2558(e)] 

This field has been disabled since prior year 
restricted funds will no longer be considered 
property tax revenue available for offset in the 
current year by county offices of education.  
For additional information refer to EC Section 
2575(e). 

N/A 

A-11 Total After clicking Save, displays the calculated totals 
of the taxes reported in Section A, lines A-1 
through A-10. 

N/A 

A-12 Community 
Redevelopment 
Funds  

Amount for community redevelopment funds that 
meet the requirements of EC sections 2575(c)(3) 
(applicable to county taxes) or 42238.03(c)(6) 
(applicable to school district taxes). 

0000 - 8047 

http://www.cde.ca.gov/fg/aa/pa
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Line 
Number 

Field 
Description Instructions 

SACS 
Resource 

and 
Revenue 
Object 
Codes 

A-13 Redevelopment 
Property Tax 
Trust Fund 
Residual 
Distributions 
[HSC sections 
34183(a)(4), 
34183.5(b)(2)(A), 
and 34188  

Amount of remittances of excess revenues 
allocated from the Redevelopment Property Tax 
Trust Fund that are distributed pursuant to Health 
and Safety Code (HSC) sections 34183(a)(4) and 
34188. Also includes amount remitted pursuant to 
HSC Section 34183.5(b)(2)(A) in the current year. 

0000 - 8047 

A-14 Redevelopment 
Agency Asset 
Liquidation [HSC 
sections 34177 
and 34179.6] 

Amount of remittances from unencumbered 
balances [HSC Section 34177(d)] and proceeds for 
asset sales and other related funds due to the wind 
down of Redevelopment Agency affairs [HSC 
Section 34177(e)]. Includes additional amounts 
remitted pursuant to a determination by the 
Department of Finance [HSC Section 34179.6(f)]. 

0000 - 8047 

A-15 College Districts 
ERAF 

This entry field is only available for county offices 
of education. Amount of ERAF disbursed to the 
California Community Colleges. 

N/A 

A-16 Excess ERAF This entry field is only available for county offices 
of education. Amount of excess funds within each 
county collected through property taxes that are 
shifted from cities, the county, and the special 
districts prior to their distribution to school 
agencies. 
This entry field is only available for county offices 
of education. 

The amount 
used to fund 

special 
education 
should be 

recorded in 
0000 - 8045. 

 
Negative numbers: Use the minus sign after a number to enter a negative value in any entry field. The 
value will then display as a negative number on the entry screen and in parentheses on the 
corresponding report. If data entered on any line is negative, please provide an explanation for each 
negative value 
 
Note regarding Miscellaneous Funds:  The Miscellaneous Funds screen is not available in the Principal 
Apportionment Tax Software. To report Miscellaneous Funds, please use the Principal Apportionment 
Data Collection Software. All agencies are required to submit a file for Miscellaneous Funds, even if the 
amount is zero. 
 
Cross-County Taxes 
 
Taxes disbursed from a county to a neighboring county for educational services rendered to students 
residing in the disbursing county are referred to as cross-county taxes. This data must be entered on the 
Taxes entry screen. Estimates of taxes to be disbursed to another county are reported at P-1 and P-2 by 
the sending county, while at Annual, the receiving county reports the actual taxes received from another 
county. See the table below for more details. 
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Period Instructions 
P-1 and  
P-2 

Do not report estimated receipts from another county at P-1 and P-2. 
 
Report to CDE estimates of any taxes to be disbursed to another county. The reporting 
county must add a new record and, using the drop down selection, choose any other 
applicable counties for which it estimates taxes will be disbursed to for the fiscal year. If an 
LEA is not available in the drop down menu please contact CDE for a Get Latest file to add 
the additional county office of education or district.  

Annual Do not report receipts disbursed to another county at Annual, otherwise those tax revenues 
will be reported twice. The county who received the revenue will report the receipt. 
 
Report to CDE all actual receipts. 
 
There is no drop down selection available for districts to report separately taxes received 
from another county. For district taxes, report all tax receipts received from the reporting 
county and any cross-counties. 
 
For COE taxes, report all tax receipts received from the reporting county. For any cross-
county tax receipts, report the amounts received using the drop down selection and choosing 
the county the taxes were received from. 

 
Prior Year Tax Adjustments 
 
Because taxes are reported on a cash basis, in most cases when reporting a tax correction for a prior 
year, adjustments should be entered on Line A-6, Distribution of Prior Year Taxes in the current fiscal 
year software. If the correction is due to an input error, but the cash was already received in the prior 
year, submit the correction in the software for the year the cash was received. Additionally, counties with 
excess Educational Revenue Augmentation Fund, may submit corrections for a prior year using the 
software for the fiscal year of the adjustment and those adjustments will be applied to the local revenue 
for the year of the adjustment due to the potential impact on the distribution of taxes within the county. 
 
Copying Tax Data from One Period to Another 
 
This software feature is provided for ease of use; however, P-1 tax data should be reviewed and 
updated as appropriate when using this feature. The P-2 reporting period must be selected to 
use this function.  
 
In the Taxes screen, you can copy tax records from P-1 reporting period records into P-2 tax records. 
You cannot copy data if the P-2 reporting period is not selected, or if no P-1 tax record existed. 
 
Tax records from P-1 reporting period must be saved before they can be copied. 
 
To copy tax record data from the P-1 reporting period to a tax record into the P-2 reporting period: 
 

1. In the Taxes screen, select Copy P-1 to P-2 from the Tools menu. The District List screen is 
displayed. 
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The following table describes the fields displayed in this screen: 
List Description 

P-1 Tax Data Captured Displays all tax records saved in the County Auditor Taxes 
screen for the P-1 reporting period. Tax records are copied 
from the items in this list. 

P-1 Tax Data to Copy to P-2 Displays selected tax records from the P-1 reporting period to 
be copied to the P-2 reporting period.  

 
2. Do one of the following to move the desired P-1 tax records from the P-1 Tax Data Captured list 

to the P-1 Tax Data to Copy to P-2 list: 
 

• To move all records to the list for copying, click the double arrow button.  All 
records now display in the P-1 Tax Data to Copy to P-2 list. 

 
• To move selected records to the list for copying, click the single arrow button. The 

selected record(s) display in the P-1 Tax Data to Copy to P-2 list. To add multiple 
records, hold the CTRL key while selecting additional records. 

 
3. Click Copy Tax Data. A dialog displays confirming that the copy operation has been completed. 

 
4. Click OK. 

 
5. Click Close to close the District List screen. To view the copied data in the Taxes screen, select 

either County or District in the Tax Type drop down list. 
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